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1 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you will sometimes also
need other Guides such as the Master Guide, Technical Infrastructure Guide, and SAP Library.

Target Groups:

® Technical Consultants

® System Administrators

® Solution Consultants

® Business Process Owners

® Support Specialists

11 Global Definitions

SAP Application: An SAP application is a SAP software solution that serves a specific business area such as ERP,
CRM, PLM, SRM, and SCM.

Business Scenario: From a microeconomic perspective, a business scenario is a cycle, which consists of several
different interconnected logical processes in time. Typically, a business scenario includes several company
departments and involves with other business partners. From a technical point of view, a business scenario needs
at least one SAP application (SAP ERP, SAP SCM, or others) for each cycle and possibly other third-party
systems. A business scenario is a unit which can be implemented separately and reflects the customer's
prospective course of business.

Component: A component is the smallest individual unit considered within the Solution Development Lifecycle;
components are separately produced, delivered, installed, and maintained.

1.2 Important SAP Notes

Caution

Check regularly for updates available for the Application Operations Guide.

SAP Dealer Business Management CUSTOMER
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Important SAP Notes
Table 2

l | | |

1.3 History of Changes

A Caution

Make sure you use the current version of the Application Operations Guide.

The current version of the Application Operations Guide is at service.sap.com/instguides on SAP Service
Marketplace.

The following table provides an overview of the most important changes in prior versions.

Table 3
1.0 Final version of the SAP DBM Application Operations Guide
2.0 Updated component for VSA in Problem Message Handover
chapter
CUSTOMER SAP Dealer Business Management
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2 Technical System Landscape

2.1

Scenario/Component Matrix

The figure below shows an overview of the technical system landscape for SAP Dealer Business Management.
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Figure 1: Technical System Landscape

2.2 Related Documentation

Super-
session

iObjects

The following table lists where you can find more information about the technical system landscape.

Table 4
Topic

Technical description for SAP Dealer
Business Management

Guide/Tool

Industry Solution Master Guide — SAP
for Automotive

Quick Link to the SAP Service

Marketplace

service.sap.com/instguides

Technical description of the underlying
technological component SAP
NetWeaver

Master Guide for SAP NetWeaver

service.sap.com/instguides

Security

service.sap.com/security

Security for Industry Scenario

Security Guide for Industry Scenarios

service.sap.com/securityguide

SAP Dealer Business Management
Technical System Landscape
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3 Monitoring of Dealer Business
Management

Within the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

You can find more information about the underlying technology in the SAP Netweaver Administrator's Guide -
Technical Operations Manual in the SAP Library under SAP Netweaver Library.

3.1 Alert Monitoring with CCMS

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP Dealer Business Management as quickly as possible.

3.1.1 CCMS Monitoring Installation and Setup

SAP Dealer Business Management is technically based on Enhancement package 1 of SAP NetWeaver 7.3 (part of
SAP enhancement package 4 for SAP NetWeaver 7.01) and thus reuses monitoring tools from NetWeaver such as
the Computing Center Management System (CCMS). Therefore, we recommend that you set up the Monitoring
Infrastructure as described in the Monitoring Setup Guide for SAP NetWeaver 7.3 located on SAP Service

Marketplace at |k service.sap.com/instguides # » SAP NetWeaver » SAP NetWeaver 7.3 » Operations »
Monitoring 3.

In order to enable the auto-alert mechanism of CCMS, see SAP Note 617547 A .

For more information about monitoring, see the Application Help for SAP NetWeaver on SAP Help Portal at

IF help.sap.com# » SAP NetWeaver » SAP NetWeaver 7.3 Including Enhancement Package 1 » Application Help »
Function-Oriented View » English » Application Server » Application Server ABAP » Administration of Application
Server ABAP » Monitoring and Administration Tools for Application Server ABAP 1.

3.1.2 Component Specific Monitoring

SAP Dealer Business Management does not have its own monitorable data and hence standard CCMS Monitor
templates are used for the purpose of monitoring the component.

The following monitor tree elements, which can be viewed with transaction RZ20 (CCMS Monitor Sets), are
provided:

e SAP DBM Monitor Templates.

This Monitor Template consists of following monitors and monitor elements:

CUSTOMER SAP Dealer Business Management
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Table 5

DBM ABAP Application Server Operating System

Database Client

R3Services

R3BasisSystem

R3Abap

R3Syslog

Security

Server Configuration

Web Dynpro ABAP

DBM Monitoring TREX Heartbeat

Version

Configuration

Performance and Activity

Use transaction RZ20 to create your own monitors based on this DBM Monitor template and monitor elements.

3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

SAP Dealer Business Management is technically based on SAP enhancement package 1 for SAP NetWeaver 7.3.
SAP Dealer Business Management does not provide additional tools for Monitoring.

For information about technical problem analysis (such as for database, operating system, or workload analysis),
see the Technical Operations Manual for SAP NetWeaver on SAP Help Portal at http://help.sap.com — SAP
NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English —
SAP NetWeaver Library — Administrator’s Guide.

3.2.1 Trace and Log Files

Trace files and log files are essential for analyzing problems.

Dealer Business Management uses several applicaton log objects/subobjects. General information about
application logs, see SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including
Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — SAP NetWeaver by
Key Capability — Solution Life Cycle Management by Key Capability — Application Log — (BC-SRV-BAL).

Log objects and corresponding subobjects used by Dealer Business Management:

SAP Dealer Business Management CUSTOMER
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Table 6
DBM ORDER Order
TILL Cashdesk
VEHICLE Vehicle

3.2.2 Workload Monitors

SAP DBM uses the standard SAP NetWeaver workload monitor. For more information, see the Technical
Operations Manual for SAP NetWeaver on SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP
NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — Technical
Operations Manual — Administration of SAP NetWeaver Systems — Application Server ABAP (AS ABAP) —
Monitoring — Tools — Workload Monitor.

3.2.3 Other Important Problem Analysis and Monitoring
Tools

This section is not relevant for SAP Dealer Business Management.

3.2.4 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

For information about interface monitoring, see the SAP Help Portal at http://help.sap.com — SAP Solution
Manager — SAP Solution Manager 7.0 SP15 —English — Solution Monitoring — Using Business Process
Monitoring — Business Process Monitoring — Set-Up Interface Monitoring

3.2.5 Data Growth and Data Archiving Monitors

SAP DBM uses the standard tools for archiving and monitoring data archiving available in SAP NetWeaver and
does not require an application specific tool. For more information, see the following source:

® http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP
NetWeaver 7.3 Library — English — SAP NetWeaver by Key Capabilitay — Key Capabilites of Solution Life
Cycle Management — Data Archiving

CUSTOMER SAP Dealer Business Management
10 (c) Copyright Monitoring of Dealer Business Management



3.3 Data Consistency

If related or identical data is stored in multiple places there may be the possibility of inconsistencies (for example
after a restore of a single component). The following table describes how consistency can be verified and how
inconsistencies may be repaired.

For SAP Dealer Business Management, data is not stored in different components, so no data inconsistencies
occur.

SAP Dealer Business Management CUSTOMER
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4 Management of SAP Dealer Business
Management

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

For more information about the underlying technology, see in the Technical Operations Manual for SAP
NetWeaver on SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including
Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s
Guide.

4.1 Starting and Stopping

SAP DBM does not provide tools for starting and stopping.

For more information, see the SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3
including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — Technical Operations Manual —
General Administration Tasks — Starting and Stopping AS ABAP and AS JAVA.

4.2 Software Configuration

SAP DBM requires no special component-specific technical configuration.

4.3 Administration Tools

SAP Dealer Management uses standard administration tools based in SAP NetWeaver. For more information, see
the Technical Operations Manual for SAP NetWeaver on SAP Help Portal at http://help.sap.com — SAP
NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English —
SAP NetWeaver Library — Administrator’'s Guide — Technical Operations Manual for SAP NetWeaver —
Administration of SAP NetWeaver Systems — AS ABAP (Application Server for ABAP) — Administration.

4.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for Dealer Business Management consists of two parts:

CUSTOMER SAP Dealer Business Management
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® Backup and restore coverage for each component (see table below)
® (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should
also be embedded in overall business requirements and incorporate your company’s entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data
center through fire. It is most important in this context that you ensure that backup devices are not lost together
with normal data storage (separation of storage locations).

Frequency of the Backup
SAP DBM

SAP DBM recommends that you back up your database on a daily basis. For more information about the
frequency of the backup, see the Technical Operations Manual for SAP NetWeaver on SAP Help Portal at http://
help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3
Library — English — SAP NetWeaver Library — Administrator’'s Guide — Technical Operations Manual for SAP
NetWeaver — General Administration Tasks — Database Administration.

SAP ERP

SAP ERP recommends that you back up your individual components in the SAP ERP 6.0 landscape regularly to
ensure that you can restore and recover them if there is a system failure. For more information about backup and
recovery for SAP ERP 6.0, see SAP Service Marketplace at http://service.sap.com/instguides — OSAP Business
Suite Applications — SAP ERP — SAP ERP 6.0 — Operations.

Backup Procedures

SAP DBM is based on SAP NetWeaver (Web Application Server ABAP) technology. All backup procedures for
ABAP-based components also work for SAP DBM. For more information about backup and recovery, see the
Technical Operations Manual for SAP NetWeaver on SAP Help Portal at http://help.sap.com — SAP NetWeaver —
SAP NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver
Library — Administrator’s Guide — Technical Operations Manual for SAP NetWeaver — Administration of SAP
NetWeaver Systems — Application Server ABAP (AS ABAP) — Administration/Management — Backup and
Restore.

Online Backup

The data contained in the database can be backed up online; however, it is not possible to do the same for the
runtime infrastructure. An online backup refers to the system landscape and not the databases that contain the
business-critical application, or the infrastructure components.

If you perform a backup while the server is running, open files may not be backed up.

Backup and Recovery of SAP NetWeaver Components

For more information about backup and restore for the usage type Application Server for ABAP and the usage
type Business Intelligence (BI), see SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver
7.3 including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library —
Administrator’'s Guide — Technical Operations Manual for SAP NetWeaver — Administration of SAP NetWeaver
Systems — Application Server ABAP (AS ABAP) — Administration/Management — Backup and Restore.

For more information about backup and restore for the usage type Process Integration (XI), see SAP Help Portal
at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP
NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s Guide — Technical Operations
Manual for SAP NetWeaver — Administration of SAP NetWeaver Systems — PI (Process Integration) —
Management — Backup/Restore and Recovery.

SAP Dealer Business Management CUSTOMER
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4.5 Application Copy

For more information, see the Technical Operations Manual for SAP NetWeaver on SAP Help Portal at http://
help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP NetWeaver 7.3
Library — English — SAP NetWeaver Library — Administrator’'s Guide — Technical Operations Manual for SAP
NetWeaver — General Administration Tasks — System Copy.

4.6 Periodic Tasks

4.6.1 Scheduled Periodic Tasks

This chapter describes all automatable tasks required to run periodically in order to keep the application running
smoothly over time. Such tasks may be required on component level and are therefore relevant in each scenario
that uses the component. You can find the mapping in the chapter Scenario / Component Matrix above. Other
tasks may be relevant for certain business scenarios only. It is important that you monitor the successful
execution of these tasks on a regular basis.

Periodic Tasks to be scheduled can be found in the Technical Operations Manual for SAP NetWeaver on SAP Help
Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 — SAP
NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s Guide — Technical Operations
Manual for SAP NetWeaver — Administration of SAP NetWeaver Systems — AS ABAP (Application Server for
ABAP) — Administration — Background Jobs and Job Monitoring.

4.6.2 Required Manual Periodic Tasks

This chapter describes all manual tasks required to run periodically in order to keep the application running
smoothly over time. A person must execute a manual task; the scheduled tasks listed above can be automated
using a task scheduler program. Such tasks may be required on component level and are therefore relevant in
each scenario that uses the component. You can find the mapping in the chapter Scenario / Component Matrix
above. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the
successful execution of these tasks on a regular basis.

For more information, see standard jobs mentioned in the Technical Operations Manual for SAP NetWeaver (in
SAP Library under SAP NetWeaver) at the SAP Portal at http://help.sap.com/ -> SAP NetWeaver -> SAP
NetWeaver 7.3 including Enhancement Package 1 -> SAP NetWeaver 7.3 Library -> English -> SAP NetWeaver
Library -> Administrator’s Guide -> Technical Operations Manual for SAP NetWeaver -> Administration of SAP
Netweaver systems -> AS ABAP -> Administration -> Background processing -> Background Jobs to Be
Scheduled Regularly.

SAP Dealer Business Management does not require manual tasks to be performed.

4.7 Load Balancing

SAP Dealer Business Management uses the standard functionality of NetWeaver for logon and load balancing. For
more information about network load balancing, see SAP Service Marketplace at http://service.sap.com/ha and

CUSTOMER SAP Dealer Business Management
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in the SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement
Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s Guide —
Technical Operations Manual for SAP NetWeaver — General Administration Tasks — High Availability — Network
High Availability — Web Server Networks and DMZs.

4.8 User Management

SAP Dealer Business Management uses the standard functionality of NetWeaver for the user management, such
as creating users with transaction SUO1 and creating and using roles with transaction PFCG. For more
information, see SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 Library
(including Enhancement Package 1) — English — SAP NetWeaver Library — Security Guide — User
Administration and Authentication.

4.9 Printing

SAP Dealer Business Management uses the standard functionality of SAP NetWeaver for printing. For more
information about printing, see SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3
including Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library —
Administrator’'s Guide — Technical Operations Manual for SAP NetWeaver — Administration of SAP NetWeaver
Systems — AS ABAP (Application Server for ABAP) — Administration — Printing.

SAP Dealer Business Management CUSTOMER
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5 High Availability

For high availability of Dealer Business Management, see the information on SAP Service Marketplace at http://
service.sap.com/ha — Media Library — Documentation — HA Documentation, or see the documentation on SAP
Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement Package 1 —
SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator's Guide — Technical Operations
Manual for SAP NetWeaver — General Administration Tasks — High Availability.

CUSTOMER SAP Dealer Business Management
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components.

6.1 Transport and Change Management

All components of SAP Dealer Business Management are client-enabled. For transport and change management
issues, the procedures of SAP NetWeaver apply. For more information, see the Technical Operations Manual for
SAP NetWeaver on SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including
Enhancement Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s
Guide — Technical Operations Manual for SAP NetWeaver — Administration of SAP NetWeaver Systems — AS
ABAP (Application Server for ABAP) — Software Logistics — Transport and Change Management.

6.2 Requests and Development Release Management

The standard procedures of SAP NetWeaver apply. See the Technical Operations Manual for SAP NetWeaver on
SAP Help Portal under SAP NetWeaver.

6.3 Quality Management and Test Management

You can use the SAP NetWeaver Development Infrastructure to learn about the various possibilities to test your
software changes.

6.4 Support Packages and Patch Implementation

We recommend that you implement the latest Dealer Business Management Support Packages. You can find
detailed information, and the support packages for download for SAP DBM 8.0, in the SAP Service Market Place
at http://service.sap.com/support.

SAP Dealer Business Management CUSTOMER
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7 Troubleshooting

For information about troubleshooting SAP NetWeaver, see the Technical Operations Manual for SAP NetWeaver
on SAP Help Portal at http://help.sap.com — SAP NetWeaver — SAP NetWeaver 7.3 including Enhancement
Package 1 — SAP NetWeaver 7.3 Library — English — SAP NetWeaver Library — Administrator’'s Guide —
Technical Operations Manual for SAP NetWeaver — General Administration Tasks — Troubleshooting for SAP
Web Application Server — SAP NetWeaver Problem Analysis Guide (PAG).

CUSTOMER SAP Dealer Business Management
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8 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

8.1 Remote Support

For information about Remote Support Setup, see SAP Service Marketplace at http://service.sap.com/access-
support.

8.2 Component Hierarchy Relevant for This Application

For information about processing of internal support messages and forwarding them to SAP, see SAP Help Portal
at http://help.sap.com — SAP Solution Manager — SAP Solution Manager 7.0 SP15 — English — Service Desk.

8.3 Remote Support Setup

For information about Remote Support Setup, see SAP Service Marketplace at http://service.sap.com/access-
support.

8.4 Problem Message Handover

For information about processing of internal support messages and forwarding them to SAP, see SAP Help Portal
at http://help.sap.com — SAP Solution Manager — SAP Solution Manager 7.0 — English — Service Desk.

For sending problem messages/tickets to SAP, choose the appropriate component (or subcomponent) name
from the SAP component hierarchy:

Table 7
IS-A-DBM Dealer Business Management
+ IS-A-DBM-ACC Accounting
+ IS-A-DBM-MD Master Data
SAP Dealer Business Management CUSTOMER
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IS-A-DBM Dealer Business Management

+ IS-A-DBM-MD-STG Storage Goods Manager

+ IS-A-DBM-MD-VEH Vehicle

+ IS-A-DBM-NTF Notification

+ IS-A-DBM-ORD Order

+ IS-A-DBM-ORD-CTL Order Control

+ IS-A-DBM-ORD-PRT Parts

+ IS-A-DBM-ORD-SCH Resource Scheduling

+ IS-A-DBM-ORD-SER Service

+ IS-A-DBM-ORD-SPL Split and Pricing

+ IS-A-DBM-ORD-UI User Interface

+ IS-A-DBM-ORD-VEH Vehicle

+ IS-A-DBM-ORD-WTY Warranty Processing

+ IS-A-DBM-FW Framework

+ IS-A-DBM-MD-CM Customer Management

+ IS-A-DBM-ACC-CD Cash Desk

+ IS-A-DBM-UI WebDynpro

+ IS-A-DBM-VSA Vehicle Sales Assistant

CUSTOMER SAP Dealer Business Management
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9 Appendix

9.1 Related Guides

You can find more information about installation and configuration in the Master Guide.

9.2 Related Information

The following table contains links to information relating to the Solution Operation Guide:

Table 8

Content

Quick Link to the SAP Service Marketplace

(service.sap.com)

Master Guide, Installation Guide and Upgrade Guide instguides
ibc

Related SAP Notes notes

Released Platforms platforms

Network Security

securityguide

network

Technical Infrastructure

ti

SAP Solution Manager

solutionmanager

SAP Dealer Business Management
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A Reference

A.l1 The Main SAP Documentation Types

The following is an overview of the most important documentation types that you need in the various phases in
the life cycle of SAP software.

Cross-Phase Documentation
SAPterm is SAP's terminology database. It contains SAP-specific vocabulary in over 30 languages, as well as
many glossary entries in English and German.
® Targetgroup:
©  Relevant for all target groups

® Current version:

©  On SAP Help Portal at [ help.sap.com & » Glossary 3

o Inthe SAP system in transaction STERM
SAP Library is a collection of documentation for SAP software covering functions and processes.
® Targetgroup:

o Consultants

o System administrators

©  Project teams for implementations or upgrades

® Current version:

©  On SAP Help Portal at help.sap.com & (also available as documentation DVD)

The security guide describes the settings for a medium security level and offers suggestions for raising security
levels. A collective security guide is available for SAP NetWeaver. This document contains general guidelines and
suggestions. SAP applications have a security guide of their own.

® Target group:
o System administrators
o Technology consultants
o  Solution consultants

® Current version:

©  On SAP Service Marketplace at service.sap.com/securityguide #

Implementation

The master guide is the starting point for implementing an SAP solution. It lists the required installable units for
each business or IT scenario. It provides scenario-specific descriptions of preparation, execution, and follow-up of
an implementation. It also provides references to other documents, such as installation guides, the technical
infrastructure guide and SAP Notes.

® Targetgroup:

©  Technology consultants

CUSTOMER SAP Dealer Business Management
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o Project teams for implementations

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

The installation guide describes the technical implementation of an installable unit, taking into account the
combinations of operating systems and databases. It does not describe any business-related configuration.

® Target group:
o  Technology consultants
©  Project teams for implementations

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

Configuration Documentation in SAP Solution Manager — SAP Solution Manager is a life-cycle platform. One of
its main functions is the configuration of business scenarios, business processes, and implementable steps. It
contains Customizing activities, transactions, and so on, as well as documentation.

® Targetgroup:

o Technology consultants

o Solution consultants

©  Project teams for implementations
e Current version:

© In SAP Solution Manager

The Implementation Guide (IMG) is a tool for configuring (Customizing) a single SAP system. The Customizing
activities and their documentation are structured from a functional perspective. (In order to configure a whole
system landscape from a process-oriented perspective, SAP Solution Manager, which refers to the relevant
Customizing activities in the individual SAP systems, is used.)

® Targetgroup:

o Solution consultants

©  Project teams for implementations or upgrades
® Current version:

© Inthe SAP menu of the SAP system under |p Tools » Customizing » IMG 3

Production Operation

The technical operations manual is the starting point for operating a system that runs on SAP NetWeaver, and
precedes the application operations guides of SAP Business Suite. The manual refers users to the tools and
documentation that are needed to carry out various tasks, such as monitoring, backup/restore, master data
maintenance, transports, and tests.

® Target group:
o System administrators

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

The application operations guide is used for operating an SAP application once all tasks in the technical
operations manual have been completed. It refers users to the tools and documentation that are needed to carry
out the various operations-related tasks.

® Target group:

©  System administrators
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o Technology consultants
o Solution consultants

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

Upgrade

The upgrade master guide is the starting point for upgrading the business scenarios and processes of an SAP
solution. It provides scenario-specific descriptions of preparation, execution, and follow-up of an upgrade. It also
refers to other documents, such as upgrade guides and SAP Notes.

® Target group:
o  Technology consultants
©  Project teams for upgrades

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

The upgrade guide describes the technical upgrade of an installable unit, taking into account the combinations of
operating systems and databases. It does not describe any business-related configuration.

® Targetgroup:
o Technology consultants
©  Project teams for upgrades

® Current version:

©  On SAP Service Marketplace at service.sap.com/instguides #

Release notes are documents that contain short descriptions of new features in a particular release or changes to
existing features since the previous release. Release notes about ABAP developments are the technical
prerequisite for generating delta and upgrade Customizing in the Implementation Guide (IMG).

® Target group:
o Consultants
o Project teams for upgrades

® Current version:

©  On SAP Service Marketplace at service.sap.com/releasenotes #

o Inthe SAP menu of the SAP system under [F Help » Release Notes 3 (only ABAP developments)
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Typographic Conventions

Table 9

oomie o

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

WWW.Sap.com e

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 A Hyperlink to an SAP Note, for example, SAP Note 123456 #
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
®  Cross-references to other documentation or published works
Example ®  Qutput on the screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

Keys on the keyboard
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(c) Copyright

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies. Please see
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